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The Yealink video conferencing systems provide an API interface for the Crestron○R  

3-Series control systems. The interface allows you to control the Yealink video 

conferencing system through the touch panels installed in the control device. 

When you successfully deploy environment and configure the Crestron○R  3-Series 

control systems, the Yealink video conferencing systems and the control devices, you 

can remotely manage certain features of your video conferencing system via the control 

device. 

The following table lists the products included in the Crestron○R  3-Series control 

systems. 

AV3 3-Series Control System○R  

CP3 3-Series Control System○R  

CP3N 3-Series Control System○R  

MC3 3-Series Control System○R  w/infiNET EX○R  

PRO3 3-Series Control System○R  

RMC3 3-Series○R  Room Media Controller 

Topics provided in this guide include: 

 Chapter 1  Deployment Environment 

 Chapter 2  Debugging Process 

 Chapter 3  Yealink VCS Panel Pages Overview 

 Chapter 4  Frequently Asked Questions 
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This chapter introduces the deployment environment, which instructs you to connect 

control and accessibility equipment. The Yealink video conferencing systems support 

TCP/IP connection and RS-232 connection. Note that if you connect the Crestron○R  

3-Series control system to the Yealink video conferencing system through TCP/IP 

connection, the Crestron○R  3-Series control system, the Yealink video conferencing 

system and the control device should be in the same network segment. Topics include: 

 Hardware Deployment 

 Software Programs 

 Yealink video conferencing systems (built-in API interface, firmware version 

X.21.0.10 or later) 

 

 A display device 
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 The control devices (PC, iPad, etc.) 

 or  

(Taking a PC and an iPad for example) 

 The Crestron○R  3-Series control systems 

 

(Taking Crestron○R  MC3 for example) 

 Ethernet cable 

 

 A router (applying to TCP/IP connection) 

 

 A USB to RS-232 cable (applying to RS-232 connection) 

 

The Yealink video conferencing systems support TCP/IP connection and RS-232 

connection. 
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TCP/IP connection is displayed as below: 

 

RS-232 connection is displayed as below: 

 

The software programs contain Crestron software, Crestron configuration programs and 

the control device configuration programs. 
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Crestron software mainly refers to Crestron Toolbox. It is used to import the 

corresponding configuration program into the Crestron○R  3-Series control system and 

the control device. 

 

Crestron provides two kinds of modules as the configuration programs. The modules 

contain a TCP/IP module and a RS-232 module. The selection of modules is depending 

on connection methods you use. 

 

Only one of these connection methods can be used at once. 

If you connect the Crestron○R  3-Series control system to Yealink video conferencing 

system through TCP/IP connection, you should use TCP/IP module. And the IP address of 

Yealink video conferencing system should be written in the configuration file. 
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Only an .lpz file requires importing into the Crestron○R  3-Series control system. 

If you connect the Crestron○R  3-Series control system to Yealink video conferencing 

system through the RS-232 connection, you should use RS-232 module and connect the 

RS-232 serial port in Crestron○R  3-Series control system to the USB port in your video 

conferencing system codec through a USB to RS-232 cable. Only an .lpz file requires 

importing into Crestron○R  3-Series control system. 

 

RS-232 serial port in Crestron○R  MC3: 

 

Control device configuration programs mainly refer to touch panels’ configuration 

programs. The touch panels are installed in the control device. 

The following table lists the configuration programs required in a PC and an iPad: 

PC 

Crestron XPanel application and .c3p file. 

For more information, please refer to Installing 

Touch Panels in a PC on page 13.  

iPad Crestron for iPad application and .xml file. 
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For more information, please refer to Installing 

Touch Panels in an iPad on page 15. 

For more information about the software programs required in other control devices, 

please contact Crestron.
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This chapter provides the debugging process. The TCP/IP connection is introduced for 

example. Topics include: 

 Installing Crestron Toolbox 

 Importing Crestron Modules 

 Installing Touch Panels 

To install Crestron toolbox in a PC: 

1. Double-click Crestron toolbox application. 

 

The Crestron Toolbox Setup Wizard is displayed as below: 

 

2. Follows the default installation process. 
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Importing a TCP/IP module into the Crestron○R  3-Series control system is introduced for 

an example. 

To import modules by Crestron toolbox: 

1. Double-click Crestron toolbox application icon    . 

2. Click on View->System Info. 

3. Click     . 

4. Mark the radio box of TCP. 
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5. Enter the IP address of the Crestron○R  3-Series control system in IP 

Address/Hostname field. 

 

6. Click OK. 

If the Crestron toolbox connects to the Crestron○R  3-Series control system 

successfully, the page will be shown as below: 
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7. Drag the vertical scroll bar to the middle position. 

 

8. Click    . 

  

9. Click Browse.... 
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10. According to the TCP/IP connection method, select an .lpz file. 

 

11. Click Send. 
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Please wait a few minutes. After the dialog box disappears, the send process is 

finished.  

 

You can remotely control the Yealink video conferencing system through the touch 

panels installed in the control device (PC, iPad, etc.).  

This section introduces the following: 

 Installing touch panels in a PC 

 Installing touch panels in an iPad 

If you open the touch panels in a PC and in an iPad synchronously, whatever operations 

you do on the touch panels in a PC or an iPad, their touch panels change synchronously. 
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To install touch panels in a PC: 

1. Double-click Crestron XPanel application. 

 

The Crestron XPanel Setup Wizard is displayed as below: 

 

2. Follows the default installation process. 

3. After installation, double-click Crestron XPanel icon     .  
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4. Click on File->Load Project. 

 

5. Select .c3p file and click Open. 
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6. After you enter the touch panels in PC, touch Settings to navigate to the Settings 

page. 

If 

You can view the version information normally, it means the touch panels in a PC are 

installed successfully.

To install touch panels in an iPad: 

1. From the Apple App Store, search for Crestron for iPad and download the 

application. 

2. In an iPad, touch the icon     to enter the Crestron for iPad. 

3. Touch UPGRADE to buy the usage right of Crestron for iPad. 

4. Touch     .  
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5. You will enter the Edit Location screen, edit the name in the Friendly Name/Location 

filed. 

 

6. Swipe the Use Local Project switch right to ON. 

7. Enter the IP address of the Crestron○R  3-Series control system in Hostname or IP 

Address field. 

 

8. Enter 04 in IP ID filed. 
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9. Touch Save. 

10. Double-click Crestron toolbox application icon     in a PC.  

11. Click on View->System Info. 

12. Click     .  

13. Mark the radio box of TCP. 
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14. Enter the IP address of the iPad in IP Address/Hostname field. 

 

15. Click OK. 

If the Crestron toolbox connects to iPad successfully, the page will be shown as 

below: 

 

12. Click    . 
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13. Click Browse.... 

 

14. Select .xml file and click Open. 
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15. Click Send. 

 

16. Touch the name you edit in the Friendly Name/Location filed in an iPad. 

17. After you enter the touch panels, touch Settings to navigate to the Settings page. 

 

If you can view the version information normally, it means the touch panels in an 

iPad are installed successfully.
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Every page in touch panels includes a menu for navigating to a different page. Many of 

the pages in touch panels also include buttons for increasing or decreasing the volume 

and muting the microphone. This chapter provides instructions for the Yealink VCS panel 

pages overview. The touch panels in an iPad are introduced for example. Topics 

include: 

 Yealink Logo Page  

 Dialing Page 

 Address Book Page 

 Camera Page 

 Input Select Page 

 IR Emulation Page 

 History Page 

 Settings Page  
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The Yealink Logo page is displayed after you have loaded the touch panels. Touch the 

Yealink Logo page to navigate to the Dialing page. 
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On the Dialing page, you can manually dial and hang up a call. 

 

No. Name Description 

1 Dial type 

Specifies the preferred call type for placing calls. 

 If you select Auto, the dial type is determined 

by the configurations on your video 

conferencing system. 

 If you select Manual, the dial type is 

determined by the configurations on your 

Settings page. For more information, please 

refer to Settings Page on page 34. 

2 DTMF  Sends DTMF tones.  

3 Input box Displays the calling information you entered. 

4 Keypad 

Provides numbers, “#” and “.”. 

If you want to dial a conference call, you should 

add a space between each phone number. 

5 Clear Clears all calling information you entered. 

6  Deletes a character each time. 
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No. Name Description 

7 DND  

Configures the type of Do Not Disturb. 

 If you select Global, DND mode applies to 

global setting. 

 If you select Call during a call, DND mode 

applies to the current call. 

8 Bar graph Reflects the current volume level. 

9 Volume  

 Touches     to increase the volume. 

 Touches     to decrease the volume. 

 Touches     to mute the microphone. 

10 Keyboard  

Opens the Dialing keyboard.  

For more information, please refer to Dialing 

Keyboard Page on page 24. 

11 Space Enters spaces. 

12 Shortcut Keys Navigates to the corresponding page. 

13 Hang up Hangs up the current call. 

14 Dial Places a call. 

To enter the Dialing Keyboard page: 

1. Touch Dialing to navigate to the Dialing page.   
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2. Touch Keyboard button to enter the Dialing Keyboard page. 

 

No. Name Description 

1 Input box Displays the calling information you entered. 

2 
 

Closes the Dialing keyboard and return to the 

dialing page.  

3 Keyboard 
Provides the QWERTY keyboard to enter the calling 

information. 

4 Enter 
Finishes entering the calling information and 

returns to the Dialing page. 
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Touch Address Book to navigate to the Address Book page. 

 

No. Name Description 

1 Type 

Provides the selection of address book type. 

 If you select All, you can view all contacts. 

 If you select Local, you can view the local 

contacts. 

 If you select Conf, you can view the 

conference contacts. 

2 Contact Details 

Display the information of the contacts in the 

selected address book.  

 If the contact has more than one number, the 

More button will be displayed, touch the More 

button to view additional numbers.  

 If the type of the contact is Conf, the More 

button will be hidden. 

3 Page 

Turns pages. 

If the number of contacts is more than one page, 

you can press     or     to turn pages. The center 

text indicates the current page and total pages. 
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No. Name Description 

4 Search 

Opens the Search Keyboard. 

For more information, please refer to Search 

Keyboard Page on page 27. 

5 Text field 

 Displays the total number of contacts in the 

current address book. 

 Displays the total number of the search results. 

To enter the Search Keyboard page: 

1. Touch Address Book to navigate to the Address Book page.  

2. Touch Search button to enter the Search Keyboard page. 

 

 

No. Name Description 

1 Input box Displays the search information you entered. 

2 
 

Closes the keyboard and return to the Address 

Book page.  
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No. Name Description 

3 Keyboard 
Provides the QWERTY keyboard to enter the search 

information. 

4 Enter Performs a search. 

To enter the Contact Details page: 

1. Touch Address Book to navigate to the Address Book page.  

2. If a contact has more than one number, select a contact and touch the More button 

to view additional numbers. 

 

No. Name Description 

1 Number 
Displays the phone numbers of the selected 

contact.  

2  
Closes the current page and return to the Address 

Book page.  

3 Text field Displays the total amount of phone numbers. 
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Touch Camera to navigate to the Camera page. On this page, you can move the 

camera, store the preset. 

 

No. Name Description 

1 Zoom out Key 

 Decreases the camera zoom or the captured 

image magnifications.  

 Behaves as page down in a multiple page list. 

2 Zoom in Key 

 Increases the camera zoom or the captured 

image magnifications. 

 Behaves as page up in a multiple page list. 

3 Navigation Key  
In the idle screen, pan and tilt the camera to adjust 

the viewing angle. 

4 Preset 

Stores the preset position of the camera or adjust 

the camera to the preset.  

You can long touch any numeric key (0-9) to save 

the current preset position of the camera. 
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Touch Input Select to navigate to the Input Select page.  

 

No. Name Description 

1 Camera Displays Camera input source. 

2 PC Displays PC input source. 

3 Share  Displays Camera and PC input source. 
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Touch IR Emulation to navigate to the IR Emulation page. The IR Emulation page 

provides 3 shortcut keys (F1, F2, F3). They can help users organize conference easily 

with intuitive and efficient operation in all pages. 

 

No. Name Description 

1 Home 

 Returns to the idle screen when in the menu 

screen. 

 Enters the pre-dialing screen during a call. 

2 Show 
Switches the input source between Camera, 

Camera and PC, or PC. 

3 Volume  

 Touches Up button to increase the volume. 

 Touches Down button to decrease the volume. 

 Touches Mute button to mute the microphone. 

4 Zoom in Key 

 Increases the camera zoom or the captured 

image magnifications. 

 Behaves as page up in a multiple page list. 
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No. Name Description 

5 Record Starts/Stops recording video. 

6 Power 
Puts the endpoint to sleep or wakes the endpoint 

up. 

7 Zoom out Key 

 Decreases the camera zoom or the captured 

image magnifications.  

 Behaves as page down in a multiple page list. 

8 F3 

Identifies context-sensitive features. 

In the idle screen, this is used to save and check the 

camera preset position, and corresponds to the 

Preset soft key. 

9 F2 

Identifies context-sensitive features. 

In the idle screen, this is used to enter the 

pre-dialing screen, and corresponds to the Call soft 

key. 

10 F1 

Identifies context-sensitive features. 

In the idle screen, this is used to enter main menu 

screen, corresponds to the Menu soft key. 

11 Screenshot Captures the image from the camera. 

12 Delete 

 Deletes the calling information you entered. 

 Long press to delete all characters in the input 

field. 

13 Navigation Key 

 In the menu screen, press    or    to switch 

menus, press    or    to select items. 

 In the idle screen, pan and tilt the camera to 

adjust the viewing angle. 

14 OK Key Confirms actions or answers incoming calls. 
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Touch History to navigate to the History page. 

 

No. Name Description 

1 Type 

Provides the selection of call history type. 

It contains all calls, placed calls, received calls and 

missed calls. 

2 Page 

Turns pages. 

If the number of entries is more than one page, you 

can press     or     to turn pages. 

3 Text field 
Displays the total amount of entries in the selected 

call history type. 
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Touch Settings to navigate to the Settings page. 

 

No. Name Description 

1 Speed  Specifies the preferred call speed for placing calls. 

2 Version information 
Displays the information of the Yealink video 

conferencing system. 

3 Storage 

Displays the status of storage. 

If you insert a USB flash drive to one of the two USB 

port for storing screenshots and recording videos, 

the icon will turn to green. 

4 Reinitialize  Reinitializes the Crestron○R  3-Series control system. 

5 Module status  
Indicates the status of the Crestron○R  3-Series 

control system. 

6 Protocols Specifies the preferred protocol for placing calls. 

7 Type Specifies the preferred call type for placing calls. 
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This chapter provides the solutions to common issues to help you solve problems you 

might encounter. Upon encountering a scenario not listed in this section, contact your 

Yealink FAE for further support. 

 Ensure WiFi is enabled on the control device, and that it is connected to the correct 

IP network. Furthermore, ensure the IP address assigned to the device is valid. 

 Ensure whether the Crestron○R  3-Series control system, the Yealink video 

conferencing system and the control device are in the same network segment.
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